PDT 1100 Terminal
Transfer Utilities Guide

70-36368-01
Revision A
December 1998
## Contents

### About This Guide
- Notational Conventions .......................................................... vii
- Related Publications ................................................................. viii
- Service Information ................................................................. viii
- Symbol Support Centers ............................................................ ix
- Warranty ...................................................................................... ix
  - Warranty Coverage and Procedure ............................................... x
  - General .................................................................................... x

### Chapter 1. Ir-Transfer Utility C

**Introduction** ................................................................. 1-1
- MS-DOS PCs that Support Ir-Transfer Utility C .......................... 1-2
- Windows PCs that Support Ir-Transfer Utility C ......................... 1-2
- File Format Supported ............................................................... 1-3
  - MS-DOS File Format ................................................................. 1-3
  - User Program Files .................................................................. 1-3
  - Data Files ............................................................................... 1-4
  - Data File Example ................................................................... 1-4
- Setting Up the PDT 1100 ............................................................ 1-6
  - Default Settings ....................................................................... 1-6
  - Setting Communications Parameters ........................................ 1-7
  - Downloading from Host .......................................................... 1-9
  - Uploading to Host .................................................................... 1-10
- Creating User Programs in BASIC 3.0 ........................................ 1-11
  - Setting Communications Parameters ........................................ 1-11
  - Source Programs ...................................................................... 1-11
  - Creating Source Program for Downloading .............................. 1-12
  - Creating Source Program for Uploading .................................... 1-12
  - Compiling the Source Program and Downloading .................... 1-13
- MS-DOS–based Ir-Transfer Utility C (IT3C.EXE) ......................... 1-15
Setting Communications and Ir Protocol Options ........................................... 1-15
  Option Lists ............................................................................................. 1-15
  Setting Options at the Command Line ..................................................... 1-16
  Setting Options With the SET Command ................................................ 1-16
  Setting Options By Creating an FLD File ................................................. 1-17
  Setting Options By Creating a Batch File ................................................ 1-17
Defaults ...................................................................................................... 1-18
Priority of Options ..................................................................................... 1-18
Specifying the File's Directory Path ........................................................ 1-18
Specifying File Name for Transfer ............................................................ 1-19
Downloading Files to the PDT 1100 .......................................................... 1-19
  Downloading Program Files .................................................................... 1-20
  Downloading Data Files ......................................................................... 1-20
  Downloading More Than One File .......................................................... 1-21
Uploading Files from the PDT 1100 to the Host ........................................ 1-21
  Uploading Program Files ........................................................................ 1-21
  Uploading Data Files ............................................................................. 1-22
  Uploading All Files ................................................................................ 1-23
Starting Ir-Transfer Utility C ..................................................................... 1-23
  By Typing at the Command Line ............................................................. 1-23
  By Setting Options to Environment Variable ......................................... 1-23
  By Setting Field Option into an FLD File .............................................. 1-23
  By Creating a Batch File ...................................................................... 1-24
Quitting Ir-Transfer Utility C ................................................................. 1-25
Windows-based Ir-Transfer Utility C (IT3CW32.EXE) ................................. 1-26
Installing Ir-Transfer Utility C ................................................................. 1-26
Using Ir-Transfer Utility C ....................................................................... 1-29
  Reading In the Initialization File .............................................................. 1-30
  Setting Communications Options ......................................................... 1-31
  Downloading to the PDT 1100 .............................................................. 1-32
  Uploading from the PDT 1100 .............................................................. 1-33
  File Transmission .................................................................................. 1-33
  Ended or Aborted File Transmission .................................................... 1-35
  Turning Toolbar On or Off ................................................................... 1-36
  Starting Help ......................................................................................... 1-36
  Quitting Ir-Transfer Utility C ............................................................... 1-37
  Writing to the Initialization File .............................................................. 1-37

Chapter 2. Ir-Transfer Utility E

Introduction ............................................................................................... 2-1
  PCs that Support Ir-Transfer Utility E .................................................... 2-1
  External IR Transceivers and IR Port-integrated Computers ................. 2-2
  File Format Supported ......................................................................... 2-2
Contents

User Program Files .............................. 2-2
Data Files .................................. 2-4
Setting up the PDT 1100 ......................... 2-7
  Default Settings .......................... 2-8
  Setting Communications Parameters ...... 2-8
  Downloading from Host .................. 2-10
  Uploading to Host ....................... 2-11
User Programs in BASIC 3.0 .................... 2-12
  Setting Communications Parameters ..... 2-12
  Source Programs ......................... 2-12
  Creating Source Program for Downloading 2-12
  Creating Source Program for Uploading .. 2-13
  Compiling the Source Program ............ 2-13
Installing Ir-Transfer Utility E (IT3EW32.EXE) 2-15
Using Ir-Transfer Utility E ................... 2-17
  Reading In the Initialization File ....... 2-18
  Setting Communications Options ........ 2-19
  Downloading to the PDT 1100 ............ 2-20
  Uploading to the Host ................... 2-21
File Transmission ............................. 2-22
  Normal End of File Transmission ....... 2-23
  Abnormal End of File Transmission ..... 2-23
  Aborted File Transmission ............... 2-24
Turning Toolbar On or Off ..................... 2-24
Starting Help ................................ 2-24
Quitting Ir-Transfer Utility E ............... 2-24
  Writing to the Initialization File ....... 2-25
Starting Ir-Transfer Utility E from the Command Line 2-25
  Directory Path Names and File Names 2-25
  Example 1 ................................ 2-25
  Example 2 ................................ 2-25
  Example 3 ................................ 2-26

Appendix A. Error Messages

MS-DOS (Ir-Transfer Utility C) ................ A-1
Windows (All Utilities) ....................... A-3
About This Guide

The PDT 1100 Transfer Utilities Guide describes the three transfer utility programs available for the PDT 1100 terminal. The chapters are set up in this way:

♦ Chapter 1, Ir-Transfer Utility C describes the Transfer Utility.
♦ Chapter 2, Ir-Transfer Utility E details Transfer Utility C.
♦ Appendix A, Error Messages lists the error codes and messages for all three utilities.

Notational Conventions

The following conventions are used in this document:

♦ Italics are used to highlight specific items in the general text, and to identify chapters and sections in this and related documents.
♦ Bullets (•) indicate:
  ♦ action items
  ♦ lists of alternatives
  ♦ lists of required steps that are not necessarily sequential
♦ Sequential lists (e.g., those that describe step-by-step procedures) appear as numbered lists.
♦ Items in regular courier font indicate constant syntax, items in italic courier font indicate variable syntax.
Related Publications

- PDT 1100 Product Reference Guide p/n 70-35864-XX
- PDT 1100 Quick Reference Guide p/n 70-35861-XX
- PDT 1100 Programmer’s Guide p/n 70-36099-XX
- PDT 1100 Basic Extension Library p/n 70-36100-XX

Service Information

If you have a problem with your equipment, contact the Symbol Support Centers. Before calling, have the model number, serial number, and several of your bar code symbols at hand.

Call the Support Center from a phone near the scanning equipment so that the service person can try to talk you through your problem. If the equipment is found to be working properly and the problem is symbol readability, the Support Center will request samples of your bar codes for analysis at our plant.

If your problem cannot be solved over the phone, you may need to return your equipment for servicing. If that is necessary, you will be given specific directions.

Note: Symbol Technologies is not responsible for any damages incurred during shipment if the approved shipping container is not used. Shipping the units improperly can possibly void the warranty. If the original shipping container was not kept, contact Symbol to have another sent to you.
Symbol Support Centers

For service information, warranty information or technical assistance contact or call the Symbol Support Center in:

**United States**
Symbol Technologies, Inc.
One Symbol Plaza
Holtsville, New York 11742-1300
1-800-653-5350

**Canada**
Symbol Technologies Canada, Inc.
2540 Matheson Boulevard East
Mississauga, Ontario, Canada L4W 422
(905) 629-7226

**United Kingdom**
Symbol Technologies
Symbol Place
Winnersh Triangle, Berkshire RG41 5TP
United Kingdom
0800 3282424 (Inside UK)
+44 118 945 7529 (Outside UK)

**Asia/Pacific**
Symbol Technologies Asia, Inc.
230 Victoria Street #04-05
Bugis Junction Office Tower
Singapore 188024
337-6588 (Inside Singapore)
+65-337-6588 (Outside Singapore)

If you purchased your Symbol product from a Symbol Business Partner, contact that Business Partner for service.

**Warranty**

Symbol Technologies, Inc. ("Symbol") manufactures its hardware products in accordance with industry-standard practices. Symbol warrants that for a period of twelve (12) months from date of shipment, products will be free from defects in materials and workmanship. This warranty is provided to the original owner only and is not transferable to any third party. It shall not apply to any product (i) which has been repaired or altered unless done or approved by Symbol, (ii) which has not been maintained in accordance with any operating or handling instructions supplied by Symbol, (iii) which has been subjected to unusual physical or electrical stress, misuse, abuse, power shortage, negligence or accident or (iv) which has been used other than in accordance with the product operating and handling instructions. Preventive maintenance is the responsibility of customer and is not covered under this warranty.

Wear items and accessories having a Symbol serial number, will carry a 90-day limited warranty. Non-serialized items will carry a 30-day limited warranty.
Warranty Coverage and Procedure

During the warranty period, Symbol will repair or replace defective products returned to Symbol's manufacturing plan in the US. For warranty service in North America, call the Symbol Support Center at 1-800-653-5350. International customers should contact the local Symbol office or support center. If warranty service is required, Symbol will issue a Return Material Authorization Number. Products must be shipped in the original or comparable packaging, shipping and insurance charges prepaid. Symbol will ship the repaired or replacement product freight and insurance prepaid in North America. Shipments from the US or other locations will be made F.O.B. Symbol's manufacturing plant. Symbol will use new or refurbished parts at its discretion and will own all parts removed from repaired products. Customer will pay for the replacement product in case it does not return the replaced product to Symbol within 3 days of receipt of the replacement product. The process for return and customer's charges will be in accordance with Symbol’s Exchange Policy in effect at the time of the exchange. Customer accepts full responsibility for its software and data including the appropriate backup thereof. Repair or replacement of a product during warranty will not extend the original warranty term. Symbol's Customer Service organization offers an array of service plans, such as on-site, depor, or phone support, that can be implemented to meet customer's special operational requirements and are available at a substantial discount during warranty period.

General

Except for the warranties stated above, Symbol disclaims all warranties, express or implied, on products furnished hereunder, including without limitation implied warranties of merchantability and fitness for a particular purpose. The stated express warranties are in lieu of all obligations or liabilities on part of Symbol for damages, including without limitation, special, indirect, or consequential damages arising out of or in connection with the use or performance of the product. Seller's liability for damages to buyer or others resulting from the use of any product, shall in no way exceed the purchase price of said product, except in instances of injury to persons or property. Some states (or jurisdictions) do not allow the exclusion or limitation of incidental or consequential damages, so the proceeding exclusion or limitation may not apply to you.
Chapter 1
Ir-Transfer Utility C

Introduction

Ir-Transfer Utility C is a program which transmits program files or data files between the PDT 1100 and the host computer via the communications unit CU-6000, using an IR beam according to the Ir protocol in the MS-DOS or Windows95/ NT environment.

The Ir-Transfer Utility C program files are:

- IT3C.EXE  MS-DOS-based Ir Transfer Utility C
- IT3CW32.EXE  Windows-based Ir Transfer Utility C

Note: Ir-Transfer Utility C requires the CU-6000. It cannot support file transmission via the computer-integrated IrDA port or external IrDA adapter.

Ir-Transfer Utility C is optionally provided in a 3.5" disk (in MS-DOS format) and supports the following functions:

- Execution of file transmission
  - Uploads program and data files from the PDT 1100 to the host
  - Downloads program and data files from the host to the PDT 1100.

- Setting communications and Ir protocol options
  MS-DOS:
  - At the MS-DOS command line
To the environmental variable IT3C
- In an FLD file (field options only)
- In a batch file.

Windows:
- In the Options for Communications dialog box from the Options menu in Ir-Transfer Utility C
- In an FLD file (field options only).

Ir protocol is the data transmission format between the PDT 1100 and the host computer. For details, refer to the PDT 1100 Product Reference Guide.

**MS-DOS PCs that Support Ir-Transfer Utility C**

Listed below are the operating system (OS) and PCs supporting MS-DOS-based Ir-Transfer Utility C.

- **OS:** MS-DOS Ver. 3.1 or later
- **PCs:** IBM PC/AT series, PS/2 series

**Note:** Use the default port address ("COM:").

**Windows PCs that Support Ir-Transfer Utility C**

Windows-based Ir-Transfer Utility C can run on PCs equipped with the Intel 80386 CPU or higher that support Microsoft Windows 95 or Microsoft Windows NT 3.51/4.0. Ir-Transfer Utility C requires at least 3 megabytes of memory and 50 kilobytes of unused hard disk space.

**Note:** Ir-Transfer Utility C cannot run with Windows version 3.1.

**Note:** The standard RS-232C interface port supports Ir-Transfer Utility C, but extended or added RS-232C interfaces do not. When using PCs with additional interface ports, designate the device name of the standard port.

If you’re using a PC where you can designate the power source, create a setting to apply power to the integrated RS-232C interface.
File Format Supported

MS-DOS File Format
Ir-Transfer Utility C supports user program files and data files made up entirely of ASCII text characters in MS-DOS or in Windows. Each record in these files is suffixed by a set of CR (0Dh) and LF (0Ah) codes, and the file is terminated by an EOF (1Ah) code (like the file format supported by a screen editor or as a sequential file in BASIC language).

<table>
<thead>
<tr>
<th>Record</th>
<th>CR</th>
<th>LF</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CR</td>
<td>LF</td>
</tr>
<tr>
<td></td>
<td>CR</td>
<td>LF</td>
</tr>
<tr>
<td></td>
<td>CR</td>
<td>LF</td>
</tr>
<tr>
<td></td>
<td>CR</td>
<td>LF</td>
</tr>
<tr>
<td></td>
<td>CR</td>
<td>LF</td>
</tr>
<tr>
<td></td>
<td>CR</td>
<td>LF</td>
</tr>
<tr>
<td>Text data</td>
<td>CR</td>
<td>LF</td>
</tr>
<tr>
<td></td>
<td>CR</td>
<td>LF</td>
</tr>
<tr>
<td></td>
<td>CR</td>
<td>LF</td>
</tr>
<tr>
<td></td>
<td>CR</td>
<td>LF</td>
</tr>
<tr>
<td>EOF</td>
<td>CR</td>
<td>LF</td>
</tr>
</tbody>
</table>

**Note:** In the Ir protocol, CR and LF codes in text data are removed, and SOH or STX (as a header) and ETX (as a terminator) are added.

If a serial number or horizontal parity (BCC) is added to transmission blocks in protocol, Transfer Utility or System Program in the PDT 1100 adds the protocol options.

When the binary file transfer is selected, Ir-Transfer Utility C can transmit data files containing all codes.

User Program Files
Ir-Transfer Utility C regards MS-DOS files with the extension .PD3 as a user program file (object program file).
In MS-DOS, a record is fixed to 128 bytes in length and suffixed by a set of CR and LF codes. If the actual record length in a program file is less than 128 bytes, the record is filled with zeros before downloading so that every record is 128 bytes. When uploading, however, zero-filled records are written into the specified text file with no modification.

**Note:** When receiving downloaded user programs, the PDT 1100 packs the two-byte ASCII characters into two 4-bit hexadecimal codes in a single byte to improve performance and availability.

### Data Files

Ir-Transfer Utility C regards MS-DOS files with an extension other than .PD3, .FN3, and .EX3 as data files.

**MS-DOS**

To download data files, designate the number of digits (field length) between 1 and 254 digits for each field comprising a record using +F field options.

**Windows**

To download data files, type the directory path and file name. Next, type the field lengths between 1 and 254 digits in the Field Length dialog box. Each field length should be 1 to 254 digits.

If the actual text data in a data file to be downloaded is less than the designated field length, the field is filled with spaces before downloading. Text data exceeding the designated field length is transmitted with the excess discarded.

**Note:** In transmission of binary files, the field length of text data should be equal to the specified field length.

### Data File Example

This section describes how to make a data file in BASIC or in the DOS editor. The file consists of ASCII text data and is formatted so that every record is suffixed by a set of CR and LF.
codes and the file is terminated by an EOF code. The name of the sample data file below is 
Master01.DAT.

```
00010005132702Potato chips00180
0001880196080Chewing gums00110
0001880196219Chocolates 00110
0001930021201Jelly beans 00230
0001940020324Peanuts 00380
0001990020138Cookies 00140
```

Each record of the Master01.DAT file consists of a 13-byte bar code data string starting 
from the head, a 12-byte product name data string from the 14th byte, and a 5-byte price 
data string from the 26th byte. The total data size is 30 bytes (13 + 12 + 5). Since a set of CR 
and LF codes is 2 bytes, the record size becomes 32 bytes.

The file has 6 records, so the file size is 192 bytes (32 x 6) plus 1 byte of an EOF code.

**In BASIC**

Create this master file (Master01.DAT) in the BASIC language, for example, as a sequential 
file on an MS-DOS PC. Following is a sample program written in QuickBASIC 4.5.

```
OPEN "Master01.DAT" FOR OUTPUT AS #3
PRINT #3, "00010005132702"; "Potato chips"; "00180"
PRINT #3, "0001880196080"; "Chewing gums"; "00110"
PRINT #3, "0001880196219"; "Chocolates"; "00110"
PRINT #3, "0001930021201"; "Jelly beans"; "00230"
PRINT #3, "0001940020324"; "Peanuts"; "00380"
PRINT #3, "0001990020138"; "Cookies"; "00140"
```

**In DOS Editor**

Create this master file in DOS editor as follows. In the DOS editor, you can add, modify, and 
delete data.

```
00010005132702Potato chips00180
0001880196080Chewing gums00110
0001880196219Chocolates 00110
0001930021201Jelly beans 00230
0001940020324Peanuts 00380
0001990020138Cookies 00140
```
The master file (Master01.DAT) is a DOS text file, so you may display it on the screen or output it to the printer by typing TYPE or PRINT at the command prompt.

C>TYPE MASTER01.DAT

C>PRINT MASTER01.DAT

Setting Up the PDT 1100

This section describes how to set up the PDT 1100 in System Mode for downloading or uploading program files or data files in Ir-Transfer Utility C. To initiate System Mode, power on the PDT 1100 while holding down the SF and 1 keys.

SYSTEM MENU
1: EXEC PROGRAM
2: DOWNLOAD
3: UPLOAD
4: SET SYSTEM
5: TEST 6: VER

Before downloading or uploading, check the default communications parameters and interface port listed below. If you need to modify them, start with Setting Communications Parameters; if not, skip to Downloading from Host or Uploading to Host.

Default Settings

Communications parameters:
- Transmission speed: 9,600 bps
- Output pulse width: 1.63 µs
- IR beam: 1.63 µs
- ID number: 00001 to 65535
- Character length: 8 bits
- Parity: None
- Stop bits: 1 bit
- Protocol: Serial N o.: ON (Adds serial numbers to data blocks.)
  Parity: ON (Adds a horizontal parity.)
  Timeout: 30 seconds
  Last Space: Ignore (ignore space codes in the tail of a data field.)

Protocol options:
- Linkup Time: 30 seconds
Ir-Transfer Utility C

Field Space       Ignore (ignores space codes in the tail of a data field.)
Interface port    Optical interface port

**Setting Communications Parameters**

To set communication options:

1. On the SYSTEM MENU, press the 4 key, then ENT. The system environment setting screen appears.

   ```
   SET SYSTEM
   1:PROGRAM 6:COM
   2:DISPLAY 7:KEY
   3:DATE/TIME
   4:BARCODE
   5:RESUME
   ```

2. Press 6, then ENT to display the SET COM screen.

   ```
   SET COM
   1:OPTICAL
   2:CONNECTOR
   3:COM PORT
   4:PROTOCOL TYPE
   ```

3. Select 4:PROTOCOL TYPE to display the communications protocol type setting screen.
   a. Press 2, then ENT to choose 2:IrProtocol which selects the Ir protocol for downloading or uploading files in System Mode or for the execution of XFILE statement in BASIC 3.0.
   b. Enter the ID number of the PDT 1100, then press the ENT key. If you do not need to modify the current setting, press the ENT key only.

   **Note:** An ID number is a five-digit decimal character string from 00001 to 65535. If the entered value is less than five digits, the ENT key does not activate.

   If you make a wrong entry, press the BS key to delete it and enter the correct data. Press the C key to return to the SET COM menu.

4. Select 3:COM PORT to switch to the interface port setting screen.

   ```
   SET COM PORT
   1:BASIC
   OPT IFC
   2:SYSTEM MODE
   OPT IFC
   ```
5. Select 2:SYSTEM MODE to select the interface port to be used for downloading or uploading files in System Mode.

6. The SET COM screen reappears. Select 1:OPTICAL to switch to the communications parameters setting screen for the optical interface.
   a. Select 1:TRANSMIT SPEED to display the transmission speed screen. Select the desired transmission.

   SET SPEED < OPTICAL >
   1:2400  4:38400
   2:9600  5:57600
   3:19200  6:115200

   **Note:** Do not select 2400 bps; it is not supported by Ir-Transfer Utility C.

   b. Select 2:PULSE WIDTH to switch to the IR beam output pulse width screen, then select the desired pulse width: 1.63µs or 3/16 Bit Time. To return to the SET OPTICAL screen, press C.

   **Note:** 1.63 µs is recommended.

c. Select 3:PROTOCOL to display the communications protocol option menu.

   SET PROTOCOL
   < OPTICAL>
   1:SERIAL NO.
   2:H. PARITY
   3:LINKUP TIME
   4:FIELD SPACE

d. Select 1:SERIAL NO. to select whether the serial numbers are added to data blocks.
   Select 2:H. PARITY to turn the horizontal parity ON or OFF.
   Select 3:LINKUP TIME to display the timeout length screen. Select the timeout length (in seconds) to be applied when a link is to be established.
   Select 4:FIELD SPACE to choose whether space codes in the tail of a data field should be ignored or handled as data.

   **Note:** If the Ir protocol has been selected, the serial number and horizontal parity settings are ignored.
7. Select 2:CONNECTOR to display the communication parameters setting screen for the direct-connect interface.

SET CONNECTOR
1:TRANSMIT SPEED
2:PARITY BIT
3:DATA BIT
4:STOP BIT
5:PROTOCOL

a. Select 1:TRANSMIT SPEED to choose the transmission speed, then press the C key to return to the SET CONNECTOR screen.

SET SPEED
< CONNECTOR >
1:1200 4: 9600
2:2400 5:19200
3:4800 6:38400

b. Select 2:PARITY BIT to choose the parity (none, odd or even). To return to the SET CONNECTOR screen, press the C key.

c. Select 3:DATA BIT to choose the desired character length (7 or 8 bits). To return to the SET CONNECTOR screen, press the C key.

d. Select 4:STOP BIT to choose the stop bit length (1 or 2). To return to the SET CONNECTOR screen, press the C key.

e. Select 5:PROTOCOL to display the SET PROTOCOL screen.

SET PROTOCOL
< CONNECTOR >
1:SERIAL No.
2:H.PARITY
3:LINKUP TIME
4:FIELD SPACE

Select 1:SERIAL No. on the SET PROTOCOL menu to select whether serial numbers are added to data blocks.
Select 2:H.PARITY to choose whether the system adds a horizontal parity.
Select 3:LINKUP TIME to select the timeout length (30, 60, 90, 120, or No Seconds) to be applied when a link is to be established.
Select 4:FIELD SPACE to choose whether space codes in the tail of a data field are ignored or handled as data.
To return to the SET PROTOCOL menu, press the C key.

**Downloading from Host**

To download files from the host to the PDT 1100:

1. Press 2 on the SYSTEM MENU to select DOWNLOAD, then press ENT. The DOWNLOAD menu appears.
Select 1: DRIVE A to download a user program file (object file compiled by the BASIC 3.0 Compiler) or data file to the RAM. A screen appears, indicating the PDT 1100 is waiting for the file to be downloaded.

Select 2: DRIVE B to download a user program file (object file compiled by the BASIC 3.0 Compiler) or data file to flash ROM. A screen appears, indicating the PDT 1100 is waiting for the file to be downloaded.

Select 3: HT <-> HT COPY to copy all files, system parameters, and calendar clock data from the connected PDT 1100. (This does not apply to downloading with Ir-Transfer Utility C.)

2. The PDT 1100 can receive more than one downloaded file in succession. After normal reception of a downloaded file, the PDT 1100 waits for subsequent files to be downloaded.

3. The following screen appears when the PDT 1100 is waiting for subsequent files to be downloaded after normal reception of SAMPLE00.PD3 file. To abort downloading, press the C key.

```
DOWNLOAD FILE
(A:)
SAMPLE00.PD3
** Completed **
YYYY/YYYY
```

**Uploading to Host**

To upload files from the PDT 1100 to the host:

1. Press 3 on the SYSTEM MENU to select UPLOAD, then press ENT. The UPLOAD menu appears.
   - Select 1: DRIVE A to upload a user program file or data file stored in RAM.
   - Select 2: DRIVE B to upload a user program file or data file stored in flash ROM.
   - Select 3: DRIVE A (ALL) to upload all files stored in RAM.
   - Select 4: DRIVE B (ALL) to upload all files stored in flash ROM.
   - Select 5: HT <-> HT COPY to copy all files, system parameters, and calendar clock data from one PDT 1100 to another PDT 1100. (This does not apply to uploading with Ir-Transfer Utility C.)

2. If you have selected "1: DRIVE A" or "2: DRIVE B," the screen shows all files stored in the selected memory. Move the cursor to a file to be uploaded using the F5 and F6 keys, and then press ENT.

3. The PDT 1100 displays a message indicating that it is waiting for a file to be uploaded.
4. The following screen indicates the PDT 1100 has completed uploading a file named SAMPLE00.PD3.

   UPLOAD FILE
   (A:)
   SAMPLE00.PD3
   ** Completed **
   YYYY/YYYY

5. If you select 3: DRIVE: A (ALL) or 4: DRIVE B (ALL) when more than one file is stored in the selected drive (RAM or flash ROM), the PDT 1100 uploads these files in succession.

### Creating User Programs in BASIC 3.0

This section describes how to create user programs using `XFILE` and `OPEN "COM:"` statements in BASIC.

### Setting Communications Parameters

Set the communications parameters for the host using the `OPEN "COM:"` statement according to the syntax of BASIC 3.0. Following is a user program which sets 9600 bps parity, 7-bit character length, and two stop bits.

```
OPEN "COM:9600,E,7,2" AS #1
```

### Source Programs

Following describes how to develop a downloading or uploading source program using the `XFILE` statement in BASIC 3.0, compile it into the user program, and download it to the PDT 1100.

Specify the Ir protocol specifications with `XFILE` (transmission direction, serial number setting, horizontal parity checking, transmission monitoring, handling of space codes in the tail of a data field, and timeout length) by setting options (R, S, P, M, T, and 1 to 9). (For details, refer to the `XFILE` statement in the BASIC 3.0 Programmer's Manual.)

---

**Note:** The `XFILE` statement uses the PDT 1100 interface port opened during the execution of the `XFILE` statement. For details about the interface port, refer to Setting Up the PDT 1100 on page 1-6.
Creating Source Program for Downloading

Following is a sample source program for downloading a data file named Master 01.DAT to the PDT 1100. In this XFILE statement, R, S, P, and M options are set. The R option designates downloading.

```basic
ON ERROR GOTO er
CLS
SCREEN 1,0
PRINT "DOWNLOADING"
OUT &h6060,2
CLOSE
OPEN "COM1:115200" AS #1
XFILE "Master01.DAT", "RM"
CLOSE #1
END
er:
  IF ERR>70 THEN
    CLS
    SCREEN 1,1
    PRINT "COMM ERROR"
    CLOSE
  ELSE
    RESUME NEXT
  END IF

Creating Source Program for Uploading

Following is a sample source program for uploading a data file named sales.DAT from the PDT 1100. In this XFILE statement, M option is set.

```basic
OUT &h6060,2
CLOSE
OPEN "COM1:115200" AS #1
XFILE "sales.DAT", "M"
CLOSE #1
END
```
Compiling the Source Program and Downloading

**MS-DOS:**
1. Compile the source program (for downloading or uploading) by the BASIC 3.0 Compiler into the object program (user program).
2. At the command line, type the user program name and options as follows to output the list file required for debugging.

   ```
   C>PDTC3 usrProgl +L +X +D>usrProgl(DBG)
   ```
3. Set up the PDT 1100 in System Mode so that it waits for a program file to be downloaded (see Setting Up the PDT 1100 on page 1-6).

**Windows:**
1. Activate the BASIC 3.0 Compiler in Windows.

   ![BASIC Compiler Window](image1)

   **Figure 1-1. BASIC Compiler Window**

2. Specify the source program file (for downloading or uploading) and compile it into the object program (user program).
3. To output list files required for debugging, select the desired item in the Compile Options dialog box, then choose OK.

   ![Compile Options](image2)

   **Figure 1-2. Compile Options**
4. Set up the PDT 1100 in System Mode so that it waits for a program file to be downloaded.

**Note:** If you try to download a data file with the same name but different field lengths as that already used in the destination memory of the PDT 1100, the data file cannot be downloaded. To download the file, delete the old file using the *KILL* statement (not the *CLFILE* statement), then download the user program designating the new master file, or an execution error occurs.
**MS-DOS-based Ir-Transfer Utility C (IT3C.EXE)**

Type IT3C at the command line to execute Ir-Transfer Utility C. When downloading, you also need to type the name of a file to be downloaded as follows.

*C>IT3C usrProgl.PD3*

**Setting Communications and Ir Protocol Options**

Ir-Transfer Utility C supports several communications options for setting the communications specifications and Ir protocol options for BCC setting, serial number setting the field length.

Following are typical option setting procedures for Ir-Transfer Utility C. If you omit an option setting, Ir-Transfer Utility C applies the default.

**Option Lists**

**Table 1-1. Communications Options**

<table>
<thead>
<tr>
<th>Options</th>
<th>Function Description</th>
<th>Default</th>
</tr>
</thead>
</table>
| +B transmissionspeed | Sets the transmission speed.  
| +Bn | n: 300, 600, 1200, 2400, 4800, 9600, 19200, 38400 (bps), or HS (High Speed) | +B9600   |
| +Pm | Sets the parity.  
| +PN  | No parity     
| +PO  | Odd parity    
| +PE  | Even parity   | +PN      |
| +Dk | Sets the character length.  
| +D7  | 7 bits        
| +D8  | 8 bits        | +D8      |
| +Si | Sets the stop bit length.  
| +S1  | 1 bit         
| +S2  | 2 bits        | +S1      |
You can specify 1 to 16 fields in a data file, each of which should be 1 to 254 digits long.

**Table 1-2. Protocol Options**

<table>
<thead>
<tr>
<th>Options</th>
<th>Function</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>+PB, −PB</td>
<td>Sets the horizontal parity (BCC).</td>
<td>+PB</td>
</tr>
<tr>
<td>+PB</td>
<td>= Yes</td>
<td></td>
</tr>
<tr>
<td>−PB</td>
<td>= No</td>
<td></td>
</tr>
<tr>
<td>+SN, −SN</td>
<td>Sets the serial number.</td>
<td>+SN</td>
</tr>
<tr>
<td>+SN</td>
<td>= Yes</td>
<td></td>
</tr>
<tr>
<td>−SN</td>
<td>= No</td>
<td></td>
</tr>
<tr>
<td>+F fieldlength</td>
<td>Sets the number of digits for fields.</td>
<td>−</td>
</tr>
<tr>
<td>+F (n)</td>
<td>(n: 1) to (254)</td>
<td></td>
</tr>
<tr>
<td>+F (i)</td>
<td>(i: 1) to (16)</td>
<td></td>
</tr>
</tbody>
</table>

---

**Note:** You can specify 1 to 16 fields in a data file, each of which should be 1 to 254 digits long.

**Setting Options at the Command Line**

Specify options at the command line by typing them one by one, as shown below.

```
C>IT3C MASTER.DAT +B4800 +PE +D7 +S2 -PB -SN +F10,13,5
```

Data file name          Communications option       Protocol options       Field lengths

To separate field lengths, use a semicolon (:) or a comma (,) as a delimiter.

MS-DOS beginners may use this entry method, although errors may be caused by mistyping. For your convenience, the SET command and DOS batch files are available.

**Setting Options with the SET Command**

The SET command enables you to assign the options to the environment variable IT3C. If you have made variable assignments once, you can omit typing the options at the command line at each time of Ir-Transfer Utility C operation. (Refer to Starting Ir-Transfer Utility C on page 1-23.)

1-16
Following is an entry example for assigning the transmission speed 9600 bps, even parity, and 7-bit character length.

C>SET IT3C=+B9600 +PE +D7

The variable IT3C can be retained until the PC is turned off or you make new variable assignments.

With the SET command, you can display the current environment settings at the command line. You can also assign the field option to the environment variable, although setting an FLD file is recommended (see the following section.)

**Setting Options By Creating an FLD File**

You can create an FLD file using the COPY command as follows. Once you have created an FLD file, you can omit typing the field option at the command line since Ir-Transfer Utility C refers to the file with the extension .FLD (FLD file) when downloading a data file.

Assign the same name to the FLD file as the data file with the .FLD extension in the same directory so that Ir-Transfer Utility C regards the file as a text file. In the following example, the name of the data file is `Master.DAT` and that of the FLD file is `MASTER.FLD`. Use a space as a delimiter to separate the field lengths.

C>COPY CON Master.FLD
FILE Master.DAT
FIELDS 10 13 5

When uploading a data file, Ir-Transfer Utility C creates an FLD file for the data file (see the file content example below) and registers the data file name and the field information in the same directory.

C>TYPE Master.FLD
* created by Ir-Transfer Utility 3C VX.XX
* Copyright (C) DENSO CORPORATION 1997 all rights reserved
file MASTER.DAT
date 1997-03-01 15:42:32
size 193
records 6
fields 13 12 5

In this example, character strings following an asterisk (*) are treated as comments and the blank lines are ignored.

**Setting Options By Creating a Batch File**

The easiest way to set options is to create a batch file using the DOS Screen Editor or the COPY command. To use the batch file, type the batch file name (in the following example)
at the command line and press the CR key. (Refer to Starting Ir-Transfer Utility C on page 1-23.)

The following example creates a batch file named M.BAT using the COPY command.

C>COPY CON M.BAT
IT3C MASTER.DAT +B9600

After entering the last line, press Z while holding down the control key to signal the end of
the file. The text file (named M.BAT in this example) is created.

In a batch file, you can specify special parameters %1 to %5 which allow you to modify or
add the options at the command line when starting Ir-Transfer Utility C. (Refer to Starting Ir-
Transfer Utility C on page 1-23.) In the following example, the batch file name is T.BAT.

C>COPY CON T.BAT
IT3C MASTER.DAT %1 %2 %3 %4 %5

Defaults

As listed in the option lists, the default settings are +B19200, +PN, +D8, +S1, +PB, and +SN.
Therefore, the following two entry examples produce the same operation.

C>IT3C prog1.PD3 +B19200 +PN +D8 +S1 +PB +SN
C>IT3C prog1.PD3

Priority of Options

When you specify options at the command line or with the SET command for environment
variable assignment, the following order of priority applies. If different specifications are set
to a same option, therefore, the specification set by the higher priority method takes effect.

1. At the command line
2. Assignment to an environment variable (by the SET command)
3. Defaults

Specifying the File's Directory Path

If you specify a file's directory path for downloading, Ir-Transfer Utility C searches through
the specified directory.

If you specify it for uploading, Ir-Transfer Utility C writes the file name into the specified
directory. If you omit it, Ir-Transfer Utility C writes the file name into the current directory.
When specifying a file’s directory path, use a backslash (\) to separate one directory name from another. The directory path appears as follows:

\[drivename:]\[\] \[directoryname\] \[directoryname\] ...

**Note:** Be sure to type a backslash (\) following a directory path; otherwise, Ir-Transfer Utility C downloads the file as a data file.

You can also specify a parent directory in the following format:

\IT3C ..\ 

Following is a command line example specifying the file’s directory path, filename, communications options, and Ir protocol options.

```
C:\IT3C B:\DAT\usrProg1.PD3 +9600 +PE +D7 +PB +F13,10,5
```

You may optionally specify a file’s directory path or a file’s path when designating a file name.

- File names and options (communications options and Ir protocol options) may be specified in any order.
- Usable characters for file names, extensions, and file's directory paths include single-byte codes of letters (A to Z), numerals (0 to 9), and symbols ($, & , #, %, ', -, @, _, ^, (, ), {, }, ~, and !).
- Ir-Transfer Utility C does not distinguish between uppercase and lowercase letters.
- File names should not start with a hyphen (-) or minus sign (-) to distinguish them from options.

**Specifying File Name for Transfer**

If you type a file name, Ir-Transfer Utility C downloads; if not, it uploads.

**Downloading Files to the PDT 1100**

If the file name extension .PD3 is specified, Ir-Transfer Utility C interprets the file as a program file; with other extensions, it interprets the file as a data file. Following are rules for naming a file to be downloaded, in accordance with the rules of MS-DOS.
The filename is one to eight characters long.

- The program file name is followed by the extension .PD3. (Ir-Transfer Utility C also supports files with the extension .FN3 or .EX3 as program files, although these extensions are reserved for future expansion.)

- The data file name may or may not be followed by an extension. If you omit the extension, also omit the period preceding the extension. The extension is within three characters and should not be .PD3, .FN3, or .EX3.

**Downloading Program Files**

To download a program file, specify the file name with the extension .PD3 at the MS-DOS command line in the following format:

```
IT3C [directorypath] programfilename [options]
```

where the directory path and options enclosed in square brackets can be omitted.

Example: To download a user program file named PROG1.PD3 located on the \SRC directory of drive B, type as follows:

```
C>IT3C B:\SRC\Prog1.PD3
```

**Downloading Data Files**

To download a data file, specify the file name and the field option (+F and the field length) at the MS-DOS command line in the following format:

```
IT3C [directorypath] datafilename +F
1stfieldlength  [{;|,} 2ndfieldlength  ...  [{;|,} nstfieldlength] [options]
```

where the directory path, the second and the following field lengths, and options enclosed in square brackets can be omitted.

**Note:** Do not use the file name extensions .PD3, .FN3, and .EX3 for data files since Ir-Transfer Utility C regards these as program files to be downloaded.

You can specify 1 to 16 fields, each of which should be 1 to 254 digits long. When specifying the field lengths following +F, use a semicolon (;) or a comma (,) as a delimiter to separate them.
Note: When specifying the field option in FLD files, use a space as a delimiter.

The total length of all data fields plus the number of the character count bytes (= the number of the fields) must be 255 bytes or less. When you transfer five 50-digit (50-byte) fields, for example, the total length of all data fields is 250 (50 x 5) bytes and the number of the character count bytes is 5. The total is 255, so the file can be transferred.

Example: To download a data file named MASTER.01 located on the \DAT directory of drive B, type as follows:

```
C>IT3C B:\DAT\MASTER.01 +F13,20,10,5
```

**Downloading More Than One File**

To download more than one file from the host to the PDT 1100, create a batch file as follows:

```
IT3CD.BAT
:LOOP
IF "%1"="" GOTO END
IT3C %1 +B19200
IF ERRORLEVEL 1 GOTO END
SHIFT
GOTO LOOP
:END
```

To execute this batch file, type the following at the command line:

```
C:\>IT3CD PROG.PD3 SAMPLE.DAT
```

The files PROG.PD3 and SAMPLE.DAT are downloaded.

**Uploading Files from the PDT 1100 to the Host**

Depending on the heading text of the uploaded file, Ir-Transfer Utility C interprets the file as a program file or a data file.

**Uploading Program Files**

To upload a program file, specify the following without a file name at the MS-DOS command line:

```
IT3C [directorypath] [options]
```
where the directory path and options enclosed in square brackets can be omitted.

Example: To upload a user program file named Prog1.PD3 to the \SRC directory of drive B, type as follows:

```
C>IT3C B:\SRC\  
```

**Note:** Be sure to type a backslash (\) following a directory path; otherwise, Ir-Transfer Utility C downloads the file as a data file.

When a user program is uploaded, it is unpacked from two hexadecimal codes in a single byte into the two-byte ASCII text data in the MS-DOS environment.

---

### Uploading Data Files

To upload a data file, specify the following at the MS-DOS command line (no file name is required):

```
IT3C [directorypath] [options]
```

where the directory path and options enclosed in square brackets can be omitted.

Example: To upload a data file to the \DAT directory of drive B, type as follows:

```
C>IT3C B:\DAT\  
```

**Note:** Type a backslash (\) following a directory path or Ir-Transfer Utility C downloads the file as a data file.

When a data file is uploaded, the data file with the extension .FLD is produced on the MS-DOS disk.
Uploading All Files
To upload all files stored in RAM or flash ROM from the PDT 1100 to the host, create a batch file as follows.

```batch
:LOOP
IT3C +B19200
IF ERRORLEVEL 1 GOTO END
GOTO LOOP
:END
```

To execute this batch file, type the following at the command line:

```
C:IT3C
```

After all files have been uploaded, press the specified abort keys (BREAK and ALT keys or their equivalent) to abort the batch.

When specifying more than one option, separate them using a space as a delimiter.

Starting Ir-Transfer Utility C
This section describes several ways to start MS-DOS-based Ir-Transfer Utility C using the file MASTER01.DAT as an example for downloading.

By Typing at the Command Line
```
C>IT3C B:\DAT\MASTER01.DAT +B9600 +PE +D7 +S2 -PB -SN +F40,30,20
```

By Setting Options to Environment Variable
Set options to an environment variable:
```
C>SET IT3C=+B9600 +PE +D7
```

Start Ir-Transfer Utility C:
```
C>IT3C B:\DAT\MASTER01.DAT +F40,30,20
```

By Setting Field Option into an FLD File
Create an FLD file (use a space to separate the field lengths):
Start Ir-Transfer Utility C (in this example, the upper line sets the communications options to an environment variable):

C>SET IT3C=+B9600 +PE +D7
C>IT3C B:\DAT\MASTER01.DAT

By Creating a Batch File

Create a batch file (use a comma or semicolon to separate the field lengths.) (After entry, press the Z key while holding down the control key.)

C>COPY CON M.BAT
IT3C A:\DAT\MASTER01.DAT B9600 +PE +S2 +F10,13,5

Start Ir-Transfer Utility C (in this example, type M only and press the CR key.)

C>M
Batch file name

If you have specified special parameters %1 to %5 in a batch file, you can modify or add options at the command line by typing the desired options when starting Ir-Transfer Utility C.

Create a batch file containing %1 to %5. (After entry, press the Z key while holding down the control key.)

C>COPY CON T. BAT
SET IT3C=+B9600
IT3C A:\DAT\MASTER01.DAT F13,12,5 %1 %2 %3 %4 %5

Start Ir-Transfer Utility C (type options to be modified or added at the command line.)

C>T +B19200 +PE

Batch file name

In this example, the even parity (+PE) is added and the transmission speed is modified from 9600 bps (set to an environment variable) to 19200 bps. That is, the above example is functionally equivalent to the following entry at the command line:
To modify the field lengths of a data file already stored in the PDT 1100, delete that data file and then download a modified data file containing the new field lengths to the PDT 1100.

**Quitting Ir-Transfer Utility C**

Ir-Transfer Utility C ends after normal file transmission, and in the following cases:

- An unrecoverable error occurs during file transmission.
- An unrecoverable error occurs at the start of Ir-Transfer Utility C.
- An abort key (BREAK or ALT keys or their equivalent) is pressed.
Windows-based Ir-Transfer Utility C (IT3CW32.EXE)

Installing Ir-Transfer Utility C

In the following instructions, the operating environment is Windows 95, drive A is the disk drive and drive C is the hard drive. To install Ir-Transfer Utility C to run with Windows 95 or Windows NT 3.51/4.0:

1. Start Windows.
2. Insert the Ir-Transfer Utility C disk in the disk drive (drive A).
3. Open drive A, and then copy the files in the WIN folder and the Readme file to an arbitrary folder.

To create shortcuts of Ir-Transfer Utility C (IT3CW32.EXE) and Readme:

1. Use the right mouse button to click the Start button, and then click Open.
2. On the Start menu, double-click Programs.

Figure 1-3. Selecting Open

Figure 1-4. Double-clicking Programs
3. Click File, point to New, then click Folder to create a new folder.

![Figure 1-5. Selecting Folder](image)

4. Type the name (e.g., TOOLS) of the new folder, then press Enter.

![Figure 1-6. New Folder](image)

5. Double-click the new folder to open it.
6. On the File menu, point to New, then click Shortcut.
7. Follow the instructions on your screen to register the shortcuts IT3CW32.EXE and Readme.txt.

![Figure 1-7. Registering Shortcuts](image)
8. These shortcuts appear in the folder (TOOLS).

**Figure 1-8. TOOLS Window**

---

**Note:** To use protocol when running Ir-Transfer Utility C, copy the TU3W32.DLL in the WIN32 folder stored in the Transfer Utility diskette, to the folder (TOOLS in the above example) where you have installed Ir-Transfer Utility C.

Ir-Transfer Utility C stores its transmission program in a DLL so that other applications may use the DLL. For details, refer to Readme.txt in the Ir-Transfer Utility C floppy disk.
Using Ir-Transfer Utility C

Click the Start button, point to Programs and TOOLS, then click It3cw32.exe. The main window (It3c for Windows95/NT) appears.

<table>
<thead>
<tr>
<th>Click this</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Send File" /></td>
<td>Open the Send File dialog box.</td>
</tr>
<tr>
<td><img src="image" alt="Receive File" /></td>
<td>Open the Receive File dialog box.</td>
</tr>
<tr>
<td><img src="image" alt="Options" /></td>
<td>Open the Options for Communications dialog box.</td>
</tr>
<tr>
<td><img src="image" alt="Version" /></td>
<td>Display the version of Ir-Transfer Utility C.</td>
</tr>
</tbody>
</table>

The toolbar contains the following buttons which provide quick ways to do tasks:
Reading In the Initialization File

When started, Windows-based Ir-Transfer Utility C reads in the initialization file named It3cw32.ini in the folder where the file to be executed is stored, to set the communications options and window sizes.

The It3cw32.ini file contains the following:

```ini
[Settings] ... Ir-Transfer Utility C setting section
ComParam=com1:19200,n,8,1
H Parity=1
Serial=1
Binaryfile=0

[Windows]
AppPosX=100 ... Windows' location & size section
```

**Caution**

Never rewrite the contents of the initialization file.
Setting Communications Options

1. From the Options menu on the main window, choose Options. The Options for Communications dialog box appears as follows.

2. Set the desired parameters.

Notes

- Protocol: This dimmed check box is available only when the TU3W32.DLL exists in the folder (e.g., TOOLS) containing IT3CW32.EXE. Clicking this check box makes the dimmed options (Parity, Data Bits, BCC Check, Stop Bits, Serial No. and Binary File Transfer) available. If this option is selected, the protocol is used in file transmission.

- Successive Reception: If you select this option, Ir-Transfer Utility C receives files in succession into the folder specified in the Receive File dialog box. It waits to receive files until you press the Abort button in the Ir Receiving dialog box or an error occurs.

- Binary File Transfer: This option becomes available if you select the protocol. If you click this check box, these files including STX, ETX, ENQ, and other transmission control characters can be transmitted using the protocol.

- Add to the Existing Data File in Data File Reception: If a file with the same name as a data file to be uploaded exists, Ir-Transfer Utility C adds the received file data to the tail of the existing data file. If not, the utility creates a new file.

- Insert Field Separators in Data File Reception: When writing a received data file, Ir-Transfer Utility C inserts field separators specified by the Field Separator option between fields.
**Downloading to the PDT 1100**

1. From the File menu on the main window, choose Send.

![Figure 1-11. Selecting Send](image)

2. The *Send File* dialog box appears as follows. Select the folder and file you want to download to the PDT 1100.

   In the Files of type box, choose All Files (*.*) or Program Files (*.*) to display all file names or program file names.

![Figure 1-12. Send File Dialog](image)

3. If a file to be downloaded is a data file and no equivalent FLD file exists, the *Field Length* dialog box appears after the file name is entered.

   ![Figure 1-13. Field Length Dialog](image)

   Type the field lengths according to the following syntax.
Ir-Transfer Utility C

\[
\text{Item1.fieldlength} \ [ \ {, \ | ; } \ Item2.fieldlength \ ... \ {, \ | ; } \ Itemn.fieldlength] \\
\]

\[n = 1 \text{ to } 16 \]
\[\text{fieldlength} = 1 \text{ to } 254\]

4. Choose the Open button to begin downloading. Use drag and drop for easy downloading. From Explorer, drag the file to be downloaded and onto It3cw32.

**Uploading from the PDT 1100**

1. From the File menu on the main window, choose Receive. The Receive File dialog box appears. Select the folder (and file name) you want to upload from the PDT 1100.

![Receive File Dialog](image1.png)

2. The default file name is (file) as shown in the File name box. As long as the default file name (file) is set, Ir-Transfer Utility C stores uploaded files with the same names as those in the PDT 1100.

3. Choose the Save button to begin uploading.

**File Transmission**

When the file name (and field length for downloading) is correctly entered, Ir-Transfer Utility C displays the Ir Sending dialog box when downloading or Ir Receiving dialog box when uploading, and starts file transmission.

![Ir Sending Dialog](image2.png)

- The "Ir Receiving" appears in uploading.
- Number of transmitted records (Serial number)/Total number of records to be transmitted.
- Click this Abort button to abort the transmission.
Ir-Transfer Utility C transmits files according to the Ir protocol. If the protocol check box is checked in the Options for Communications dialog box, the utility transmits files according to the protocol.

During file transmission (while the Ir Sending or Ir Receiving dialog box is displayed), no mouse entry or key entry is permitted on the main window of Ir-Transfer Utility C. If the transmission is completed or aborted by pressing the Abort button, control returns to the main window and mouse entry or key entry becomes possible.

During file transmission, control can be transferred to another application.

If a file name other than the default file name (file) is set in uploading, the uploaded file is given the designated file name and saved in the designated folder.

When uploading a data file, Ir-Transfer Utility C creates an FLD file with the same name as that of the data file but with the extension .FLD, as follows. If this file is already present, Ir-Transfer Utility C updates its content.

![Figure 1-16. Creating FLD File](image)

file: Parent file name
date: Date and time when the file is uploaded
size: File size
record: Number of records
fields: Field lengths
**Ended or Aborted File Transmission**

**Normal End of File Transmission**
If file transmission completes normally, the following code, message and file name appear on the main window of Ir-Transfer Utility C.

![Figure 1-17. Normal Transmission](image)

**Abnormal End of File Transmission**
If an error occurs during file transmission, the error code, message and file name appear on the main window. For error information, refer to Appendix A, Error Messages.

![Figure 1-18. Abnormal File Transmission](image)

**Aborted File Transmission**
If you click the Abort button in the Ir Sending or Ir Receiving dialog box to abort file transmission, the following error code, message and file name appear on the main window.

![Figure 1-19. Aborted File Transmission](image)
If files have been sent or received in succession, the transmission results appear on adjacent lines; if not, the results appear every other line.

Figure 1-20. Files Received in Succession

**Turning Toolbar On or Off**
From the View menu, click Toolbar to make the toolbar visible or invisible.

Figure 1-21. View Toolbar

**Starting Help**
From the Help menu, choose About lt3cw32 to display the version of lt3cw32.
Quitting Ir-Transfer Utility C
Quit Ir-Transfer Utility C using one of the following methods:

♦ Choose Exit from It3cw32 from the File menu on the main window.
♦ Press the F4 key while holding down the Alt key.

Writing to the Initialization File
When closing, Ir-Transfer Utility C writes the current communications options and window sizes into the initialization file named It3cw32.ini.

If no initialization file exists, Ir-Transfer Utility C creates a new initialization file in the folder where Ir-Transfer Utility C is stored and then writes the current communications options and window sizes into it.
Chapter 2
Ir-Transfer Utility E

Introduction

Ir-Transfer Utility E is a program which transmits program files or data files between the PDT 1100 and the host computer using an IR beam according to the Ir protocol in the Windows 95 or Windows NT 3.51/4.0 environment. The Ir-Transfer Utility E program file is IT3EW32.EXE.

Ir-Transfer Utility E is optionally provided on a 3.5" disk, and supports the following functions:

- Execution of file transmission
  - Uploads program and data files from the PDT 1100 to the host
  - Downloads program and data files from the host to the PDT 1100.
- Setting communications and Ir protocol options
  - In the Options for Communications dialog box from the Options menu in Ir-Transfer Utility E
  - In an FLD file (field options only)
  - At the command line in the MS-DOS window in Windows.

The PDT 1100 uses the Ir protocol for its data transmission format between the PDT 1100 and the host computer. For details, refer to the PDT 1100 User's Manual.

PCs that Support Ir-Transfer Utility E

Ir-Transfer Utility E can run on PCs equipped with the Intel 80386 CPU or higher capability (Pentium 75 MHz CPU or higher recommended) and capable of operating on the following:
Ir-Transfer Utility E requires at least 3 megabytes of memory and 50 kilobytes of unused hard disk space.

**Note:** Ir-Transfer Utility E cannot run with Windows version 3.1.

If you’re using a PC that you can designate the power source, create a setting to apply power to the integrated RS-232C interface.

**External IR Transceivers and IR Port-integrated Computers**

External IR transceivers and IR port-integrated computers that support Ir-Transfer Utility E are described in Readme.txt on the Ir-Transfer Utility E disk.

**File Format Supported**

**User Program Files**

Ir-Transfer Utility E regards MS-DOS files with the extension .PD3 as user program files (object program files). Use the BASIC 3.0 Compiler to develop these files.

As shown below, each record in a user program file is fixed to 128 bytes in length (except for the last record) and suffixed by a set of CR and LF codes (CR-LF codes), 0Dh and 0Ah. The last record has an EOF (1Ah) suffix.

<table>
<thead>
<tr>
<th>Record Length (128 bytes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
</tr>
<tr>
<td>CR</td>
</tr>
<tr>
<td>LF</td>
</tr>
<tr>
<td>CR</td>
</tr>
<tr>
<td>LF</td>
</tr>
<tr>
<td>CR</td>
</tr>
<tr>
<td>LF</td>
</tr>
<tr>
<td>Program data</td>
</tr>
<tr>
<td>CR</td>
</tr>
<tr>
<td>LF</td>
</tr>
<tr>
<td>CR</td>
</tr>
<tr>
<td>LF</td>
</tr>
<tr>
<td>CR</td>
</tr>
<tr>
<td>LF</td>
</tr>
</tbody>
</table>
When downloading a program file, if the length of the last record is less than 128 bytes, zeros replace blank bytes (128 bytes minus last record length).

<table>
<thead>
<tr>
<th>Record Length (128 bytes)</th>
<th>CR</th>
<th>LF</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CR</td>
<td>LF</td>
</tr>
</tbody>
</table>

When downloading:

<table>
<thead>
<tr>
<th>Record Length (128 bytes)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Zero codes</td>
</tr>
</tbody>
</table>

In the Ir protocol, CR-LF codes used as a record separator in data are removed before file transmission.

**Note:** When receiving downloaded user programs, the PDT 1100 packs two-byte ASCII characters each into two 4-bit hexadecimal codes in a single byte to improve performance and memory availability.
Data Files

Ir-Transfer Utility E regards MS-DOS files with extensions other than .PD3, .FN3, and .EX3 as data files. As shown below, each record in a data file consists of one or more fields and is suffixed by a set of CR and LF codes (CR-LF codes), 0Dh and 0Ah. An EOF (1Ah) code can be omitted.

Data files can be made up of arbitrary characters (00h to FFh) as well as ASCII text characters.

<table>
<thead>
<tr>
<th>Record Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field 1</td>
</tr>
<tr>
<td>CR</td>
</tr>
<tr>
<td>CR</td>
</tr>
<tr>
<td>CR</td>
</tr>
<tr>
<td>CR</td>
</tr>
<tr>
<td>EOF</td>
</tr>
</tbody>
</table>

To download data files, type the folder and file names. In the Field Length dialog box, type the desired field lengths. Each field should be 1 to 254 digits in length and the number of fields should be 1 to 16. The total field length (record length) plus the number of fields should be 255 or less.

You may designate field lengths in a file with the same file name as a file to be downloaded but with the extension .FLD in the folder where a file to be downloaded resides. If a data file is uploaded, Ir-Transfer Utility E creates a field definition file (which has the same name as the uploaded file but with the FLD extension) in the folder where the uploaded file is stored. For the file format, refer to File Transmission on page 2-22.
If the record length is different from the specified record length

When downloading a data file, if the record length is less than the specified record length, space codes (20h) replace blank bytes; if it exceeds the specified record length, the excess is discarded.

<table>
<thead>
<tr>
<th>Specified record length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
</tr>
<tr>
<td>Record 2</td>
</tr>
<tr>
<td>Record 3</td>
</tr>
</tbody>
</table>

where:
Record 1 = specified record length
Record 2 < specified record length
Record 3 > specified record length.

<table>
<thead>
<tr>
<th>Record Length (128 bytes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
</tr>
<tr>
<td>Record 2</td>
</tr>
<tr>
<td>Record 3</td>
</tr>
</tbody>
</table>

where:
Record 1: As is
Record 2: Blank bytes filled with space codes
Record 3: Excess data is discarded.
Handling CR-LF codes in records

Ir-Transfer Utility E recognizes characters 00h through FFh as data; however, it usually interprets CR-LF codes in records as a record separator. If a record in a data file to be transmitted contains CR-LF codes, Ir-Transfer Utility E divides the record according to the record separator as follows.

<table>
<thead>
<tr>
<th>Specified record length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record ( n_1 )</td>
</tr>
</tbody>
</table>

where Spaces are divided into two blocks in transmission.

To treat CR-LF codes as data, click the check box of the Handle CR-LF in Records as Data in the Options for Communications dialog box to select the option. CR-LF codes in records are transmitted as data as shown below.

<table>
<thead>
<tr>
<th>Specified record length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record ( n_1 )</td>
</tr>
</tbody>
</table>

Even if you select the Handle CR-LF in Records as Data option, use CR-LF codes as a record separator. If there is any record whose length is less than or more than the specified record length in a file, an error (error code 76) occurs and transmission is aborted.
For the details about the Options for Communications dialog box, refer to Setting Communications Options on page 2-19.

**Note:** If you selected Handle CR-LF in Records as Data in Ir-Transfer Utility E for downloading data files, select Data on the space code handling screen in System Mode to treat space codes in the tail of a data field as data (or in BASIC 3.0, specify the T option to "protospec" in the XFILE statement). If "Ignore" is selected, the PDT 1100 ignores space codes in the tail of a data field and data is not transferred correctly.

For space code handling, refer to Setting Communications Parameters on page 2-8. For details about the XFILE statement, refer to the BASIC 3.0 Programmer's Manual.

### Setting up the PDT 1100

This section describes setting up the PDT 1100 in System Mode for downloading or uploading program files or data files. To initiate System Mode, power on the PDT 1100 while holding down the SF and 1 keys.

```
SYSTEM MENU
1:EXEC PROGRAM
2:DOWNLOAD
3:UPLOAD
4:SET SYSTEM
5:TEST 6:VER
```

Before downloading or uploading, check the default communications parameters and interface port listed below. If you need to modify them, start with Setting Communications Parameters on the next page; if not, skip to Downloading to the PDT 1100 or Uploading to the Host.
Default Settings

Communications parameters
- Transmission speed: 9,600 bps
- Output pulse width of IR beam: 1.63 µs
- ID number: 00001 to 65535
- Communications protocol: protocol
- Protocol options:
  - LINKUP TIME: 30 seconds
  - FIELD SPACE: Ignore (ignore space codes in the tail of a data field.)

Interface port: Optical interface port

Setting Communications Parameters

To set communications parameters:

1. Press the 4 key on the SYSTEM MENU, then ENT. The system environment setting screen appears.

   SET SYSTEM
   1:PROGRAM 6:COM
   2:DISPLAY 7:KEY
   3:DATE/TIME
   4:BARCODE
   5:RESUME

2. Press 6, then ENT to display the communications protocol type setting screen.

   SET COM
   1:OPTICAL
   2:CONNECTOR
   3:COM PORT
   4:PROTOCOL TYPE

3. Press the 4 key, then ENT.

   PROTOCOL TYPE
   1:Protocol
   2:IrProtocol

4. Press 2 to select the Ir protocol for downloading or uploading files in System Mode or executing the XFILE statement in BASIC 3.0. The SET ID screen appears.

5. Enter the ID number of the PDT 1100 (five-digit decimal character string from 00001 to 65535) using the numerical keys, then press ENT. If you do not need to modify the current setting, press the ENT key only.
Note: If the entered value has fewer than five digits, the ENT key is not activated.

If you make a wrong entry, press the BS key to delete it and enter the correct data. Press the C key to return to the SET COM menu.

6. Select 3:COM PORT to display the interface port setting screen.

   SET COM PORT
   1: BASIC
   OPT IFC
   2: SYSTEM MODE
   OPT IFC

7. Select 2:SYSTEM MODE to choose the interface port to be used for downloading or uploading files in System Mode.

8. Select 1:OPTICAL on the SET COM screen to display the communications parameters setting screen for the optical interface.

9. Select one of the following options using the numerical keys or F5 and F6 keys, and press ENT. To return to the SET COM menu, press the C key.
   a. 1:TRANSMIT SPEED displays the transmission speed screen. Select the desired transmission speed.

      SET SPEED
      < OPTICAL >
      1: 2400 4: 38400
      2: 9600 5: 57600
      3: 19200 6: 115200

   b. 2:PULSE WIDTH displays the IR beam output pulse width screen. Select 1:1.63us for 1.63 ms (recommended) or 2:3/16 Bit Time.

   c. 3:PROTOCOL displays the communications protocol option menu.

      SET PROTOCOL
      < OPTICAL >
      1: SERIAL No.
      2: H.PARITY
      3: LINKUP TIME
      4: FIELD SPACE

   • Select 1 to display the serial number ON/OFF screen.
   • Select 2 to display the horizontal parity ON/OFF screen.

Note: If the Ir protocol is selected, the serial number and horizontal parity settings are ignored.
Select 3 to display the timeout length screen, then select the timeout length (in seconds) to be applied when a link is to be established.

SET LINKUP TIME
< OPTICAL >
1:30  4:120
2:60  5:None
3:90

Select 4 to display the space code handling screen. Select whether space codes in the tail of a data field are ignored or treated as data.

Note: If the Handle CR-LF in Records as Data option is selected in Ir-Transfer Utility E for downloading data files, select 2:Data, so every record in a data file must be fixed in length (as described in Data Files on page 2-4) so that space codes in the tail of a data field are data, not fill characters.

Downloading from Host

To download files from the host to the PDT 1100:

1. Press 2 on the SYSTEM MENU to select DOWNLOAD and then press ENT. The DOWNLOAD menu appears.

   DOWNLOAD
   1:DRIVE A
   2:DRIVE B
   3:HT<->HT COPY

   Select 1:DRIVE A to download a user program file (object file compiled by the BASIC 3.0 Compiler) or data file to RAM.
   Select 2:DRIVE B to download a user program file (object file compiled by the BASIC 3.0 Compiler) or data file to flash ROM.
   Select 3:HT<->HT COPY to copy all files, system parameters, and calendar clock data from the connected PDT 1100. (This does not apply to downloading with Ir-Transfer Utility E.)

2. A screen appears indicating the PDT 1100 is waiting for files to be downloaded.

3. The PDT 1100 can receive more than one downloaded file in succession. After a downloaded file is received, the PDT 1100 waits for subsequent files to be downloaded.

4. The following screen appears when the PDT 1100 is waiting for subsequent files to be downloaded after normal reception of SAMPLE00.PD3 file.
To abort downloading, press the C key.

**Uploading to Host**

To upload files from the PDT 1100 to the host:

1. Press 3 on the SYSTEM MENU to select UPLOAD and press ENT. The UPLOAD menu appears.

   **UPLOAD**
   - 1:DRIVE A
   - 2:DRIVE B
   - 3:DRIVE A (ALL)
   - 4:DRIVE B (ALL)
   - 5:HT<->HT COPY

2. Select 1:DRIVE A to upload a user program file or data file stored in RAM.
   Select 2:DRIVE B to upload a user program file or data file stored in flash ROM.
   Select 3:DRIVE A (ALL) to upload all files stored in RAM.
   Select 4:DRIVE B (ALL) to upload all files stored in flash ROM.
   Select 5:HT<->HT COPY to copy all files, system parameters, and calendar clock data from one PDT 1100 to another PDT 1100. (This does not apply to uploading with Ir-Transfer Utility E.

3. If you have selected "1:DRIVE A" or "2:DRIVE B," the screen shows all files stored in the selected memory. Move the cursor to a file to be uploaded using the F5 and F6 keys, and then press the ENT key.

4. The PDT 1100 displays a screen indicating that it is waiting for a file to be uploaded.

5. The following screen appears when the PDT 1100 has successfully completed uploading the file named SAMPLE00.PD3.

   **UPLOAD FILE**
   (A:)
   SAMPLE00.PD3
   ** Completed **
   YYYY/YYYY

If you select 3:DRIVE A (ALL) or 4:DRIVE B (ALL) when more than one file is stored in the selected drive (RAM or flash ROM), the PDT 1100 uploads those files in succession.
User Programs in BASIC 3.0

This section describes how to create specific user programs using XFILE and OPEN "COM:" statements in BASIC 3.0.

Setting Communications Parameters

Set communications parameters for the host using the OPEN "COM:" statement according to the syntax of BASIC 3.0. Following is a user program which sets 9600 bps.

OPEN "COM:9600" AS #1

Source Programs

Use the XFILE statement in BASIC 3.0 to develop a source program for downloading/uploading data files in Ir protocol. Compile the program into the user program, then download it to the PDT 1100.

Specify the Ir protocol specifications with the XFILE (transmission direction, transmission monitoring, handling of space codes in the tail of a data field, and timeout length) by setting options (R, M, T, and 1 to 9). (For details, refer to the XFILE statement in the BASIC 3.0 Programmer's Manual.)

Note: If you have selected the Handle CR-LF in Records as Data option in Ir-Transfer Utility E for downloading data files, specify the T option to "protocolspec" in the XFILE statement so every record in a data file must be fixed in length (as described in Data Files on page 2-4) and space codes in the tail of a data field are actual data, not fill characters.

The XFILE statement uses the PDT 1100 interface port opened by the XFILE statement.

Creating Source Program for Downloading

Following is a sample source program for downloading a data file named Master 01.DAT to the PDT 1100. In this XFILE statement, R and M options are set. The R option designates downloading.

ON ERROR GOTO er
CLS
SCREEN 1,0
PRINT "DOWNLOADING"
OUT &h6060,2
CLOSE
OPEN "COM1:115200" AS #1
XFILE "Master01.DAT", "RM"
CLOSE #1
END

ER:
IF ERR>70 THEN
  CLS
  SCREEN 1,1
  PRINT "COMM ERROR"
  CLOSE
  END
ELSE
  RESUME NEXT
END IF

Creating Source Program for Uploading

Following is a source program example for uploading a data file named sales.DAT from the PDT 1100. In this XFILE statement, M option is set.

OUT &h6060,2
CLOSE
OPEN "COM1:115200" AS #1
XFILE "sales.DAT", "M"
CLOSE #1
END

Compiling the Source Program

1. Activate the BASIC 3.0 Compiler in Windows.

![Figure 2-1. BASIC Compiler Window](image)

2. Specify the source program file (for downloading or uploading) and compile it into the object program (user program).
3. To output list files required for debugging, select the desired item in the Compile Options dialog box, then choose OK.

![Figure 2-2. Compile Options](image)

**Note:** If you try to download a data file with the same name but different field lengths as one on the destination drive of the PDT 1100 (RAM or flash ROM), the data file cannot be downloaded. To download the file, delete the old file using the KILL statement (not the CLFILE statement), then download the user program designating the new file. Otherwise, an execution error occurs.

If your PDT 1100 system version is 1.01 or earlier, select the IrProtocol on the PROTOCOL TYPE screen in System Mode (see Setting Communications Parameters on page 2-8) beforehand since you cannot designate the Ir protocol with "OUT &h6060, 2" in these versions.
Installing Ir-Transfer Utility E (IT3EW32.EXE)

In the description below, the operating environment is Windows 95, Drive A is the disk drive and drive C is the hard disk. To install Ir-Transfer Utility E to run with Windows 95 or Windows NT 3.51/4.0:

1. Start Windows.
2. Insert the Ir-Transfer Utility E disk into the disk drive (drive A).
3. Open drive A, then copy the files from the disk to an arbitrary folder.

To create a shortcut of Ir-Transfer Utility E (IT3EW32.EXE):

1. Use the right mouse button to click Start, then click Open.
2. On the Start Menu, double-click Programs.

3. Click File, point to New, and then click Folder to create a new folder.

4. Type the name (e.g., TOOLS) of the new folder, then press Enter.
5. Double-click the new folder to open it.
6. On the File menu, point to New, and then click Shortcut.
7. Follow the instructions on your screen to register the shortcut IT3EW32.EXE.

Figure 2-5. Registering Shortcuts

The shortcut appears in the folder (TOOLS).

Figure 2-6. Shortcut Icon
Using Ir-Transfer Utility E

Click the Start button, point to Programs and TOOLS, then click It3ew32.

The following main window (It3e for Windows95/NT) appears.

From the File menu, choose Send (download), Receive (upload), Recent file, or Exit command.

From the Help menu, display the version of Ir-Transfer Utility E.

From the View menu, make the toolbar visible or invisible.

From the Options menu, set the communications options and IR devices.

Figure 2-7. Selecting It3ew32

Figure 2-8. It3e Window
Reading In the Initialization File

When started, Windows-based Ir-Transfer Utility E reads in the initialization file named It3ew32.ini in the folder where the file to be executed is stored to set the communications options and window sizes.

The It3ew32.ini file contains the following:

```
[Settings]  ... Ir-Transfer Utility E setting section
ComParam=com1:9600
IrDeviceName=  
HandleCR-LF=0
SeqRcv=0
Append=0  
Delimit=0  
DelimitChar=

[Directory]  ... File transmission dialog section
SendDir=
ReceiveDir=
```

Table 2-1. Quick Access Buttons

<table>
<thead>
<tr>
<th>Click this</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="open.png" alt="Icon" /></td>
<td>Open the Send File dialog box. (See Downloading to the PDT 1100 on page 2-20.)</td>
</tr>
<tr>
<td><img src="open.png" alt="Icon" /></td>
<td>Open the Receive File dialog box. (See Uploading to the Host on page 2-21.)</td>
</tr>
<tr>
<td><img src="open.png" alt="Icon" /></td>
<td>Open the Options for Communications dialog box. (See Setting Communications Options on page 2-19.)</td>
</tr>
<tr>
<td><img src="display.png" alt="Icon" /></td>
<td>Display the version of Ir-Transfer Utility E.</td>
</tr>
<tr>
<td><img src="exit.png" alt="Icon" /></td>
<td>Exit from Ir-Transfer Utility E.</td>
</tr>
</tbody>
</table>
Ir-Transfer Utility E

[Windows] ... Windows' location & size section

AppPosX = 100
AppPosY = 100
AppSizeX = 350
AppSizeY = 202

Caution

Never rewrite the contents of the initialization file.

Setting Communications Options

1. From the Options menu on the main window, choose Options. The Options for Communications dialog box appears.

![Options for Communications Dialog](image)

Figure 2-9. Options for Communications Dialog

2. Set the parameters for the communications options.
   a. Infrared Devices: Clicking the down arrow at the right side of the Infrared Devices option shows the IR devices that Ir-Transfer Utility E supports in the ComboBox. For the product names for these IR devices, refer to Readme.txt.
   b. Handle CR-LF in Records as Data: If you select this option, Ir-Transfer Utility E treats CR LF codes in records as data. If this option is not selected, they are treated as a record separator. For details about this option, refer to Data Files on page 2-4.
c. Successive Reception: If you select this option, Ir-Transfer Utility E receives files in succession into the folder specified in the Receive File dialog box. It stands by to receive files until you press the Abort button in the Ir Receiving dialog box or an error occurs.

d. Add to the Existing Data File in Data File Reception: If a file with the same name as a data file to be uploaded exists, Ir-Transfer Utility E adds the received file data to the tail of the existing data file. If not, the utility creates a new file.

During data file reception with this option specified, if Ir-Transfer Utility E is aborted or detects any communications error, it restores the original data file.

e. Insert Field Separators in Data File Reception: When writing a received data file, Ir-Transfer Utility E inserts field separators specified by the Field Separator option between fields.

f. Specify Timeout for Link Establishment: Specify the timeout length (in seconds) to be applied when a link is to be established. The entry range is from 0 to 65535. Specifying 0 performs no timeouts. If a data link cannot be established within the specified timeout length, an error (error code 51 or 52) occurs.

If this option is not specified, the default timeout length (30 seconds) applies.

**Downloading to the PDT 1100**

To download files from the host to the PDT 1100:

1. Choose Send from the File menu on the main window.
2. The Send File dialog box appears. Select the folder and file to download to the PDT 1100.

In the Files of type box, choose Program Files (* .pd3), Program Files (* .fn3, *.ex3), or All Files (* * ) to display file names.
If a file to be downloaded is a data file and no field definition file (FLD file) exists in the directory in which the file is located, the Field Length dialog box appears after the file name is entered. Type the field lengths according to the following syntax:

\[ \text{Item1.fieldlength} [\{, | ;\} \text{Item2.fieldlength} \ldots [\{, | ;\} \text{Itemn.fieldlength}] \]

\[ n = 1 \text{ to } 16 \]
\[ \text{fieldlength} = 1 \text{ to } 254 \]

1. Choose the OK button to begin downloading.

**Note:** Use drag and drop for easy downloading. From Explorer, drag a file to be downloaded and drop it onto It3ew32.

### Uploading to the Host

To upload files from the PDT 1100 to the host:

1. From the File menu on the main window, choose Receive.

![Figure 2-11. Selecting Receive](image)

2. The Receive File dialog box appears. Select the folder (and file name) to upload from the PDT 1100.

![Figure 2-12. Receive File Dialog](image)
The default file name is (file) as shown in the File name box. When the default file name (file) is set, Ir-Transfer Utility E stores uploaded files with the same names as those in the PDT 1100.

To change the name, rename the (file) in the File name box.

1. Choose the Save button to begin uploading.

**Note:** If user programs are uploaded, program codes packed into two 4-bit hexadecimal codes each in a single byte by the PDT 1100 are unpacked to two-byte ASCII text data in the host computer.

### File Transmission

When the file name (and field length for downloading) is entered, Ir-Transfer Utility E displays the **Ir Sending** dialog box when downloading, or **Ir Receiving** dialog box when uploading, and then starts file transmission.

**Figure 2-13. Ir Sending Dialog**

- During file transmission (while the **Ir Sending** or **Ir Receiving** dialog box is displayed), no mouse entry or key entry is permitted on the main window. If transmission is completed or aborted by pressing the Abort button, control returns to the main window to permit mouse or key entry.

  During file transmission, control can be transferred to the other application.

- If a file name other than the default file name (file) is set in uploading, the uploaded file is given the designated file name and saved in the designated folder.
When uploading a data file, Ir-Transfer Utility E creates a field definition file with the same name as that of the data file but with the extension .FLD. If this file is already present, Ir-Transfer Utility E updates its content.

Figure 2-14. Creating Field Definition File

- file: Parent file name
- date: Date and time when the file is uploaded
- size: File size
- record: Number of records
- fields: Field lengths

**Ended or Aborted File Transmission**

**Normal End of File Transmission**
If file transmission is normally completed, the following code, message and file name appear on the main window of Ir-Transfer Utility E.

Figure 2-15. Normal Transmission Window

**Abnormal End of File Transmission**
If an error occurs during file transmission, the error code, message and file name appear on the main window. For the error information, refer to Appendix A, Error Messages.
Aborted File Transmission

If you click the Abort button in the Ir Sending or Ir Receiving dialog box to abort file transmission, the following error code, message and file name appear on the main window.

Figure 2-16. Error Message

If files were sent or received in succession, transmission results appear on adjacent lines; if not, the results appear every other line.

Figure 2-17. Successive Files

Turning Toolbar On or Off

From the View menu, click Toolbar to make the toolbar visible or invisible.

Starting Help

From the Help menu, choose About It3ew32... to display the version of It3ew32.

Quitting Ir-Transfer Utility E

Use one of the following methods to quit Ir-Transfer Utility E:

- Choose Exit from It3ew32 from the File menu on the main window of Ir-Transfer Utility E.
- Press the F4 key while holding down the Alt key.
- If the toolbar is displayed, click .
Writing to the Initialization File

When Ir-Transfer Utility E closes, it writes the current communications options, IR device, and window sizes into the initialization file named It3ew32.ini. If no initialization file exists, a new initialization file is created in the folder where Ir-Transfer Utility E resides and then writes the current values into it.

Starting Ir-Transfer Utility E from the Command Line

You may start Ir-Transfer Utility E from the command line in the MS-DOS window in Windows 95 or Windows NT 3.51/4.0. At the command prompt, type in the following format:

```
C:\IT3EW32 [options] [[directorypath] filename] [options]
```

To transmit a file automatically when Ir-Transfer Utility E starts, specify the filename. If no filename is specified, Ir-Transfer Utility E ignores the designated options and displays the main window.

Directory Path Names and File Names

`directorypath`
Directory path of a file to be sent or received. Specify either an absolute path or relative path. Omitting this option causes Ir-Transfer Utility E to look for that file in the current working directory. Specification of `directorypath` only is not allowed.

`filename`
Name of a file to be sent or received. To transmit a file automatically when Ir-Transfer Utility E starts, this specification is mandatory. If you type (file) for `filename` and set the +R option (specifying file reception), Ir-Transfer Utility E creates a receive file with the original file name used in the PDT 1100.

Example 1

Sending a file (TEST.DAT) by specifying the relative path:

```
C:\PDT_TOOLS\IT3EW32 ..\TEST.DAT
```

Example 2

Receiving a file by specifying the absolute path and filename (TEST.DAT), not using the original file name used in the PDT 1100:

```
C:\PDT_TOOLS\IT3EW32 +R +B115200 C:\TEST\TEST.DAT
```
Example 3

Receiving a file with the original file name used in the PDT 1100, by specifying the absolute path:

```
C:\PDT_TOOLS\IT3EW32 +R +B115200 C:\TEST\(file)
```

<table>
<thead>
<tr>
<th>Options</th>
<th>Functions</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>+B</td>
<td>transmission speed</td>
<td>Sets the transmission speed. +Bn  n = 2400, 9600, 19200, 38400, 57600, or 115200</td>
</tr>
<tr>
<td>+P</td>
<td>portnumber</td>
<td>Sets the communications port. +P1 = COM 1, +P2 = COM 2, +P3 = COM 3, +P4 = COM 4</td>
</tr>
</tbody>
</table>
| +F      | fieldlength | Sets the number of digits for fields. Item1.fieldlength[{}, {,}]
            Item2.fieldlength ... [{,}]
            Itemn.fieldlength
            n = 1 to 16 fieldlength = 1 to 254
            (Example) +F8, 10, 20
            If no corresponding field definition file (FLD file) exists in the directory where a file to be downloaded is located, enter the field lengths. -- |
| +I, -I  | determines whether to initialize the IR device. +I" DLLfilename" initializes the IR device specified by DLLfilename at the start of file transmission. The DLLfilename is IT3Exxx.DLL (except for IT3EW32.DLL) enclosed by double quotes. -I Does not initialize the IR device. -I |
**Table 2-2. Option Defaults (Continued)**

<table>
<thead>
<tr>
<th>Options</th>
<th>Functions</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>+R, +RC, -R</td>
<td>Sets the transmission direction. +R creates a receive file with the specified file name in the specified directory, and receives a file from the PDT 1100. If more than one file is specified, Ir-Transfer Utility E uses the first file name and ignores subsequent names. +RC creates a receive file with the name of the original file transmitted from the PDT 1100 in the specified directory, and receives files in succession. If more than one file is specified, Ir-Transfer Utility creates a receive file in the directory where the first file name is located. (Example) Successive reception in the specified directory (C:\TEST) C:&gt;IT3EW32 +RC +B115200 C:\TEST(file) +R Transmits the specified file. You may specify more than one file.</td>
<td>-R</td>
</tr>
<tr>
<td>+A, -A</td>
<td>Determines whether to add a received file data to the existing data file. +A adds a received file data to the tail of the existing data file. -A overwrites the existing data file with a received data file.</td>
<td>-A</td>
</tr>
<tr>
<td>+E, -E</td>
<td>Determines whether to terminate IT3EW32.EXE after file transmission. +E terminates IT3EW32.EXE after file transmission. Specifying +E sets the -V option (communications status dialog box OFF). To display the dialog box, specify the +V option. -E does not terminate IT3EW32.EXE after file transmission.</td>
<td>-E</td>
</tr>
<tr>
<td>+T, -T</td>
<td>Determines whether to insert field separators. +T' DelimiterChar' inserts field separators specified by DelimiterChar between fields when writing a received data file. Enclose DelimiterChar in single quotes. -T Does not insert field separators.</td>
<td>-T</td>
</tr>
</tbody>
</table>
If the same option is set more than once with different specifications, the more recent one has priority.

Defaults listed in this table apply only when no initialization file (IT3EW32.INI) exists. If the initialization file exists, setting conditions stored in the file apply by default.
Appendix A
Error Messages

This Appendix describes error messages encountered during operation of the Transfer Utilities.

**MS-DOS (Ir-Transfer Utility C)**

Listed below are error messages which appear if an error occurs during execution of Ir-Transfer Utility C. Error messages 01 through 09 may appear at the start of the transfer utility and prevent it from starting.

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>--</td>
<td>Normal end.</td>
</tr>
<tr>
<td>01</td>
<td>Designated file not found.</td>
<td>Transfer utility could not find the designated file.</td>
</tr>
<tr>
<td>02</td>
<td>File name entered in wrong format.</td>
<td>You entered the filename in wrong format.</td>
</tr>
<tr>
<td>03</td>
<td>Number of records exceeds 32767.</td>
<td>The total number of the records specified in a file exceeds 32767.</td>
</tr>
<tr>
<td>04</td>
<td>Field length is out of range.</td>
<td>The data field is out of the range from 1 to 254 digits in length.</td>
</tr>
<tr>
<td>05</td>
<td>Number of field lengths is out of range.</td>
<td>The number of fields is out of the range from 1 to 16.</td>
</tr>
<tr>
<td>Code</td>
<td>Message</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>--------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>06</td>
<td>Record length is out of range.</td>
<td>The total number of designated fields and length of all data fields exceeds 255 bytes.</td>
</tr>
<tr>
<td>07</td>
<td>Parameter mismatch.</td>
<td>You entered the field option (undefined option) which is not to be specified for downloading a program file.</td>
</tr>
<tr>
<td>08</td>
<td>Field length not found.</td>
<td>You entered no field option required for downloading a data file.</td>
</tr>
<tr>
<td>09</td>
<td>Option mismatch.</td>
<td>You entered an undefined option.</td>
</tr>
<tr>
<td>51</td>
<td>Communications error.</td>
<td>The sending timer has timed out.</td>
</tr>
<tr>
<td>52</td>
<td>Communications error.</td>
<td>The receiving timer has counted up to 1.</td>
</tr>
<tr>
<td>53</td>
<td>Communications error.</td>
<td>The NAK sending counter has counted up to 10.</td>
</tr>
<tr>
<td>54</td>
<td>Communications error.</td>
<td>The NAK receiving counter has counted up to 10.</td>
</tr>
<tr>
<td>55</td>
<td>Communications error.</td>
<td>The sending station receives an EOT in response to the sent text.</td>
</tr>
<tr>
<td>70</td>
<td>Illegal heading text format.</td>
<td>The received heading text contains any of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>File name in wrong format;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>More than 32767 records;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number of fields out of the range from 1 to 16 in the data file;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data field length out of the range from 1 to 254 digits;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Total length of all data fields plus the number of the character count bytes (=the number of the fields) exceeding 255 bytes</td>
</tr>
<tr>
<td>71</td>
<td>Path not found.</td>
<td>The designated path has not been found.</td>
</tr>
<tr>
<td>72</td>
<td>Disk memory full.</td>
<td>The disk memory is full.</td>
</tr>
<tr>
<td>90</td>
<td>Aborted by break key.</td>
<td>Transfer utility was aborted by pressing the Break and Alt keys.</td>
</tr>
<tr>
<td>99</td>
<td>General failure.</td>
<td>Any other error has occurred.</td>
</tr>
</tbody>
</table>
Windows (All Utilities)

Listed below are error messages which appear if an error occurs during execution of a transfer utility.

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Transmission ended normally.</td>
<td>Normal end.</td>
</tr>
<tr>
<td>1</td>
<td>Designated file not found.</td>
<td>Transfer utility could not find the designated file.</td>
</tr>
<tr>
<td>2</td>
<td>File name entered in wrong format.</td>
<td>You entered the filename in wrong format.</td>
</tr>
<tr>
<td>3</td>
<td>Number of records exceeds 32767.</td>
<td>The total number of the records specified in a file exceeds 32767.</td>
</tr>
<tr>
<td>4</td>
<td>Field length is out of range.</td>
<td>The data field is out of the range from 1 to 254 digits in length.</td>
</tr>
<tr>
<td>5</td>
<td>Number of field lengths is out of range.</td>
<td>The number of fields is out of the range from 1 to 16.</td>
</tr>
<tr>
<td>6</td>
<td>Record length is out of range.</td>
<td>The total number of designated fields and length of all data fields exceeds 255 bytes.</td>
</tr>
<tr>
<td>7</td>
<td>Parameter mismatch.</td>
<td>You entered the field option (undefined option) which is not to be specified for downloading a program file.</td>
</tr>
<tr>
<td>8</td>
<td>Field length not found.</td>
<td>You entered no field option required for downloading a data file.</td>
</tr>
<tr>
<td>9</td>
<td>Option mismatch.</td>
<td>You entered an undefined option.</td>
</tr>
<tr>
<td>51</td>
<td>Communications error.</td>
<td>The sending timer has timed out.</td>
</tr>
<tr>
<td>52</td>
<td>Communications error.</td>
<td>The receiving time has counted up to 1.</td>
</tr>
<tr>
<td>53</td>
<td>Communications error.</td>
<td>The NAK sending counter has counted up to 10.</td>
</tr>
<tr>
<td>54</td>
<td>Communications error.</td>
<td>The NAK receiving counter has counted up to 10.</td>
</tr>
<tr>
<td>55</td>
<td>Communications error.</td>
<td>The sending station receives an EOT in response to the sent text.</td>
</tr>
</tbody>
</table>
### Table A-2. Windows Error Messages (Continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>60</td>
<td>In sending.</td>
<td>The DLL has been running in sending operation.</td>
</tr>
<tr>
<td>61</td>
<td>In receiving.</td>
<td>The DLL has been running in receiving operation.</td>
</tr>
</tbody>
</table>
| 70   | Illegal heading text format. | The received heading text contains any of the following: 
File name in wrong format; 
More than 32767 records; 
Number of fields out of the range from 1 to 16 in the data file; 
Data field length out of the range from 1 to 254 digits in the data file; 
Total length of all data fields plus the number of the character count bytes (= the number of the fields) exceeding 255 bytes |
| 71   | Path not found. | The designated directory path has not been found. |
| 72   | Disk memory full. | The disk memory is full. |
| 74   | Designated timers not available. | The designated timers have been occupied by any other applications. |
| 75   | Designated port not available. | The designated RS-232C communications port (COM x:) has been occupied by any other application. |
| 76   | Record format invalid. (Ir-Transfer Utility E only) | In a file there is a record whose length is less than or more than the specified record length. |
| 80   | IR device initialization failed. (Ir-Transfer Utility E only) | Ir-Transfer Utility E has failed to initialize the IR device. |
| 81   | Designated IR device driver not found. (Ir-Transfer Utility E only) | The correct DLL has not been found. |
| 82   | Designated transmission speed not supported. (Ir-Transfer Utility E only) | The IR device does not support the designated transmission speed. |
## Table A-2. Windows Error Messages (Continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>90</td>
<td>Aborted by break key.</td>
<td>Transfer utility was aborted by clicking the Abort button.</td>
</tr>
<tr>
<td>99</td>
<td>General failure.</td>
<td>Any other error has occurred.</td>
</tr>
</tbody>
</table>
Index-2

M
M S-DOS files .......................... 1-3
M S-DOS-based Ir-Transfer Utility C ...... 1-15

N
notational conventions .................. vii

P
PCs supporting Ir-Transfer Utility C ...... 1-2
PCs supporting Ir-Transfer Utility E ...... 2-1
program files
Ir-Transfer Utility C .................... 1-1

Q
quitting Ir-Transfer Utility C .......... 1-37

R
related publications .................. viii

S
service information ................... viii
SET command .......................... 1-16
setting up
Ir-Transfer Utility C .................. 1-6
setting up PDT 1100 ................... 2-7
source programs
compiling .............................. 1-13, 2-13
Ir-Transfer Utility C .................. 1-12
Ir-Transfer Utility E .................. 2-12
starting Ir-Transfer Utility E .......... 2-25
symbol support center ................ ix
System Mode ........................... 2-7
Ir-Transfer Utility C .................. 1-6

T
toolbar
Ir-Transfer Utility C .................. 1-26
Ir-Transfer Utility E .................. 2-24

U
uploading
data files .......................... 1-22
Ir-Transfer Utility C ................. 1-10, 1-21
Ir-Transfer Utility E ................ 2-11
program files .......................... 1-21
user program files ..................... 1-3, 2-2
user programs
BASIC ................................... 2-12
using Ir-Transfer Utility C ........... 1-29
using Ir-Transfer Utility E .......... 2-17

W
Windows-based Ir-Transfer Utility C .... 1-26
Tell Us What You Think...

We’d like to know what you think about this Manual. Please take a moment to fill out this questionnaire and fax this form to: (516) 738-3318, or mail to:

Symbol Technologies, Inc.
One Symbol Plaza  M/S B-4
Holtsville, NY  11742-1300
Attn: Technical Publications Manager

IMPORTANT: If you need product support, please call the appropriate customer support number provided. Unfortunately, we cannot provide customer support at the fax number above.

User’s Manual Title: _______________________________________________
(please include revision level)

How familiar were you with this product before using this manual?

☐ Very familiar  ☐ Slightly familiar  ☐ Not at all familiar

Did this manual meet your needs? If not, please explain. ______________
_________________________________________________________________

What topics need to be added to the index, if applicable? ______________
_________________________________________________________________

What topics do you feel need to be better discussed? Please be specific.
_________________________________________________________________
_________________________________________________________________

What can we do to further improve our manuals?_______________________
_________________________________________________________________
_________________________________________________________________

Thank you for your input—We value your comments.